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Abstract

This technical report describes the reporting features introduced with NetApp®
OnCommand® Unified Manager 6.2 for NetApp ONTAP® management software.
Instructions are provided for implementing this capability in OnCommand 6.3 through 7.3
and how to create and manage custom reports, including how to export and import external
reports. This report also provides examples and reference information for creating native
and custom reports within OnCommand Unified Manager installations.
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1 Purpose

This document is designed to help OnCommand Unified Manager administrators and storage
administrators effectively use the reporting and custom reporting functionalities in Unified Manager

versions 6.3 through 7.x.

Note: We worked with Eclipse, an open-source integrated development environment (IDE), for the
custom reports in this documentation.

Note:

All Unified Manager releases through UM 7.0 have reached End of Version Support (EVOS). Please
check the Software Version Support page for supported Unified Manager releases.

2 Glossary of Terminology

Table 1) Technical Report Terminology

| Acronym Description
BIRT Businessintelligence reporting tool from OpenText; the embedded reporting
engine in OnCommand Unified Manager
Eclipse Open-source IDE used to create reportdefinitions for BIRT
IDE Integrated developmentenvironment
FQDN Fully qualified domain name
REST Representational state transfer
SWM Storage virtual machine
.war Web application archive
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3 Introduction

An IT environment requires the accurate and comprehensive reporting of its assets to optimize operations
and improve asset use. These reports can be informational, for measuring storage and
capacityinformation, or for administrative purposes. As the number of reports increases, so does the
complexity of the reporting process.

4 Reporting Feature Overview

Unified Manager provides a reporting feature that includes a library of standard reports about the
underlying NetApp storage infrastructure. With these reports, administrators can easily obtain the
information that they need to effectively manage their NetApp FAS and All Flash FAS systems. If
preferred, administrators can customize reports to capture only the desired data objects with the
extended reporting capabilities in Unified Manager.

Unified Manager further extends the custom reporting capabilities with the addition of annotation tables.
With this capability, administrators can simplify the process of customizing reports with the ability to
expose annotation tables as a database view.

Figure 1) Annotation enhances the reporting capabilities of Unified Manager.

Unified Manager extended custom reporting capabilities.

e Enable both the aggregate and the wolume history to be exposed as a database view, facilitating
custom reports to capture capacity utilization metrics

e Expose protection relationships as database views for users to build custom reports, as shown in
Figure 2

e Import custom reports without table elements in the report design (see Section 9: Portability of
(Custom) Reports for details)
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Figure 2) Unified Manager extends annotation enhancements.

Note: The annotations and history options displayed above are not currently available with standard
reports.

4.1 OnCommand Unified Manager Report Features

OnCommand Unified Manager reports provide storage visibility and analytics for NetApp FAS and All
Flash FAS. Operating as agentless browser-based software, Unified Manager reports allow
administrators to create extensive reports on:

e Operations management. Events, sewerity, and status trend charts

e Capacity. Storage summary, aggregate, volume, gtree

e Inventory. Cluster, storage virtual machine (SVM), volumes

e Protection relationships

With the Unified Manager reporting feature, administrators can:

e Customize core reports for additional use cases:

— Group, filter, sort, add compute fields, hide, and delete at the column level (for each column) in
the report.

— Get hints to customize the preceding list of additional use cases.
e Export and import report definitions to enable sharing of information.
e Schedule and share reports; view reports in PDF, CSV, XLS, HTML, or TXT format.

e Group storage resources with a single identifier for analysis and reporting; for example, by business
function or by application.

e Make full use of Eclipse, a third-party tool, to create custom, comprehensive reports that can be
imported to import Unified Manager as a design template.
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5 Architecture Overview

OnCommand Unified Manager 6.x ships with standard reports in the following categories:

Capacity utilization
Operational
Inventory

e Data protection

In addition, users can create custom reports or support third-party reports with the OpenText BIRT
component. An integrated development environment (IDE) connects to the Unified Manager database
over port 3306 by using a MySQL Java Database Connectivity (JDBC) driver. Users can interact to view
reports online (in real time), offline through sharing or exporting, or through scheduling of standard and
imported reports.

Note: Although this technical report provides guidance on creating custom reports from available IDES,
NetApp does not support issues that users might incur with the custom reports that are created.
The creation, management, and maintenance of custom reports are the responsibility of the
customer.

A database has been added to the Unified Manager server (ocum_report). It is accessible by users who
have been defined with a report schema role. The database provides wrapper views to imported reports
that are created by using Eclipse. BIRT uses various customized feature-rich REST APIs for background
tasks: share, schedule, and import reports created from IDESs.

5.1 OnCommand Unified Manager Reporting Architecture

The application server in OnCommand Unified Manager comes with two main application archive (WAR)
files:
e dfm-app.war contains UM content.

o dfm-report-app.war is a wrapper over the third-party Actuate BIRT component; the WAR file
contains canned report designs.
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In addition, an intermediate dfm-report.war is available to help port to the OnCommand product
foundation.

Figure 3) OnCommand Unified Manager reporting architecture

dfm-report-
app.war

BIRT: Business Intelligence and Reporting Tool

6 Granular Reportingwith Annotations

6.1 Annotation

With annotation, users can tie SVMs, wolumes, and clusters into a single group for better manageability.
An annotation is a combination of a name-value pair that can be applied to storage objects in NetApp
ONTAP——clusters, SVMs, and wlumes—using user-defined rules. With this capability, users can create
storage tags that can be used for reporting and administration of storage objects linked to that tag.

An annotation name refers to the metadata that is associated with storage objects. And storage objects
can be associated with one or more unique annotation names. Examples of an annotation include an
application, a data center, and a business unit.
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An annotation value is the value associated with an annotation name, suchas:
Data Center = New York, Application = Exchange, Business Unit = Finance

With OnCommand Unified Manager 6.4 and later, users can create custom annotations by applying rules
to augment supported storage objects—clusters, SVMs, and wlumes. The following conditions hold true
for annotation association:

e A given storage object can associate any number of annotation labels with it.

e A storage object can have only one annotation value for a given annotation name.

6.2 Create Annotations

To create an annotation, use the following procedure:

1. Login to Unified Manager as the OnCommand administrator.

€ > C -

NetApp OnCommand Unified Manager Help ~ | Administration ~ | umadmin | Sign Out
Manage Alerts

iy Events Storage ~ Protection v Jobs Reports All ‘ Manage Annotations Q

Manage Data Sources

Quick Takes @

Manage Events
Availability Capacity Performance Pri Manage Groups

Manage Scripts

Heaithy 17/ At Risk M Have Incidents Heaithy 7/ At Risk Ml Have Incidents Heaithy [ At Risk I Have Incidents Warning M Error
Manage Users

Database Backup

- ) 15 . 4 | Setup Options

17 38
0 [ ] 0 0 1 1 0 0 0 0 0 0 0 0

2. Navgate to Administration - Manage Annotations.
In the Manage Annotations window, click Add Annotation.

Manage Annotations &

Annotations Annotation Rules

You can manage storage objects in your environment by ing them with i ion rules enable dynamic association of annotations with storage objects. You can associate storage objects to a predefined annotation or
create a new custom You can apply to storage objects such as clusters, volumes, and Storage Virtual Machines (S\VMs)

Annotation: data-priority Actions v

_— Description:
gata-prionty.(3) Created By: SYSTEM

Creation Date: 14 Jul 2016

Annotation=Value Pairs

+ X
Value Applic able Clusters Applic able S'VMs Applic able \Volumes @
data-priority=mission-c ritic al 0 1] 0 o
data-priority=high 0 0 0
data-priority =low 0 0 0
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3. Onthe Add Annotation screen, enter:
e The annotation name
e Adescription of the annotation
Click Save and Close.

’

1Rules | Add Annotation €9 X

ts in your environment by associ Annotation N X AP [ouc
n. You can apply annotations to s nnotation Name: | Applic ation

Description: | All storage units servicing backend applic ations

Annotation: d

Desc ription:
Created By:
Creation Date:

Annotation=Valu Annotation Values
Add XD e Add X Dot
Value Value »plice
 data-priority=miss
data-priority =high
data-priority =low

Object Associat Save and Close | | Cancel

Rank a Namw v R e e e A T ¥ reove o monOtati

4. Add values to the annotation:
e Click Add.
e Enterthe value name for tagging.
e Click Add to sawe.

Annotation: Application

Description: All storage units servicing backend applic ations
Created By: umadmin
Creation Date: 12 Aug 2016

Annotation=Value Pairs

Yale Add Annotation Value x
No data four
Value: ‘ Exchange / 3
Add | Cancel |
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5. Define the annotation value conditions with rule definitions. Doing so associates all storage objects
matching the annotation “Application” and the value “Exchange.”

c e Bk i T
r events 2

Add Annotation Rule &9 X

lanage Anngptati ? N i TNG

{ 3 L Name: |Exchange e 2 \

Annotations | Annotation Rules s = \ J
™ Target Object Type: | Volume v e

Annotation rules autom@“,‘gﬁy apply annotat
sbjects. New rules~” 4ed are added to the

Apply Annotation: | Applic ation Vv | | Exchange \ v
A 1 \ X B R @ conditions / 4 - \ o=
Rank <4 V. \ / \ :
L y . \
. > RS ¢ % 5
No data found Object Name v | | Contains Vv | |exchange \ J
Y 7 7 \\\ 4
~ 1\ /1 -
+ | Add Condition 1\ d
= /|
\ s
\ 7
+ | Add Condition Group WY \ ) \
A — N
S i
F 4 N\ — N F
\
N
"
| ..'\
( 9 )
\ ———
N\ S—
e’ Save and Add Add Cancel

To complete Stepb, follow these stepsm as shown in the previous screenshot:

1. Click Annotation Rules to open the Annotation Rule window.

2. Enter the name of the rule.

3. Associate the rule to a storage object type from the drop-down menu.
4. Associate the rule to the annotation name created earlier.

5. Select the value to which to attach this rule.

6, 7, 8. Create filtering definitions to augment storage objects to this value (Additional conditions can
be included for advanced filtering.).

9. Review the definitions, click Save and Add, and close the window.
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7 Reporting Dashboard

The reporting dashboard is the main page on which reports are categorized and listed:
e Capacity utilization

e Operational reports

e Inventory reports

e Data protection reports

e Imported reports

To navigate to the reporting dashboard, click the Reports tab at the top navigation bar.

Figure 4) OnCommand Unified Manager Reports dashboard

NetApp OnCommand Unified Manager

ey Events Storage - Protection - Jobs Al -

Reports | Import Report | | Manage Report Schedules | Visit Online Automation Store

@0
@

arch

Capacity Utilization
Operational Reports
Inventory Reports

Data Protection Reports

Imported Reports

The first four categories contain standard reports. To view the reports available within a category, click
“+”, Each of these reports can be customized as described in Section 7.2 Enhance Standard Reports.

In addition, imported reports can also be customized using Eclipse (free license open-source report
designer) or the OpenText Actuate Analytics Designer (free commercial-grade designer). To customize
imported reports, the BIRT reporting engine must be installed on the system. See Section 8 Custom
Reports for more information.

7.1 Reporting Functions

The reporting function in OnCommand Unified Manager provides a comprehensive view of all NetApp
ONTAP devices in the environment. This view assists administrators with operational tasks such as
capacity and operations management. With this capability, users can perform the following reporting
functions:

e View reports under the reporting categories listed in the dashboard, as mentioned earlier.

e Runa report.

e Schedule areport.

e Customize standard reports.

e Import a report using the third-party Eclipse designer tool.
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View Reports

Each of the reporting categories can be expanded to view the specific reporting capabilities available. For
example, the following standard reports are available within the Data Protection category.

Figure 5) Sample of standard dataprotectionreports

E‘ Data Protection Reports

Volume Data Protection Configuration Run Report

The Volume Data Protection Configuration report helps you to analyze the unprotected volumes utilized in a cluster, understand the passible risks to the volumes and view the data details of the
protected and unprotected volume.

Volume Relationships Inventory Run Report

The Wolume Relationships Inventory report helps you to analyze the storage inventory details of a cluster, understand the degree of protection required for volumes, and filter the volumes based on
source offailure, pattern and schedule

Volume Transfer Status (Historical) Run Report

The Volume Transfer Status report provides you a detailed overview of the volume transfer trends over a period of fime. The report also displays whether the volume transfer was a success or a
failure

Volume Transfer Rate (Historical) Run Report

The “olume Transfer Rate report provides you an overview of the volume transfer activity on a day to day basis. The report also displays details about the total amount of volume transferred on each
day

Run a Report

To run a report, expand the category, then click the Run Report button next to the desired report to open -
the Report Details page.

Figure 6) Unified Manager Reports page

NetApp OnCommand Unified Manager Help ~ | Administzation - | umadmin | Sign Out
R Events Storage -~ Protection = Jobs Reports Al w | Search Qs
Reports § Import Report | | Manage Report Schedules | Visit Online Automation Store Collapse /

[=] capacity utilization

Storage Summary ﬁ‘ Run Report

Analyze storage capacity and utilization of your storage system to quickly understand key areas such as capacity risks, and availability trends.

Aggregate Capacity and Utilization Run Report

Analyze aggregates capacity and utilization in a cluster to understand possible capacity risks and to view the configured, used, and unused capacity of aggregates.

Schedule a Report

The scheduling feature allows you to define the specific time to run a report, with the ability to
automatically send to administrators and other recipients by email. A variety of formats is supported,
including PDF, HTML, CSV, Excel, and so on.
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To schedule a report, go to the individual report summary page. Click Manage Report Schedules and
complete the following fields, as shown in Figure 7:
Schedule Name

Recipient Email Address

Report Format

Frequency (of the reporting intervals)

Date and Time

Report Category

Select Available Reports

Click + to add to the Schedule

Click Save to complete the Task

© XN ®O®DNPE

Note: Use the drag-and-drop feature to add specific fields within the schedule.

Figure 7) Example of report scheduling process

NetApp OnCommand jigs
Manage Report Schedules &) -
g Events
Schedules (0)
Add Schedule Schedule Name: "

Report: Storage Summary |

Scheduled: No Mo schedule exists. Recipient Email Address

Enter email addresses separated by commas.

= Report Format. (@) POF HKHTML csv Excel Tsxe
o Frequency Hourly Daily ® Weekly Menthly

Storage Capacity Utilization Ov at [HH:MM | on | Select Day ¥
= Report Category Capacity v @

=

Z A

E 4 Available Reports Selected Reports

L Storage Summary

= Aggregate Capacity and Utilization

!E - “olume Capacity and Utilization

E‘ = Qtree Capacity and Utilization

&

g

Cluster

£ fasB060-39-238-241
+ I 9

| Cancel

7.2 Enhance Standard Reports

You can further customize standard reports in the native Ul by selecting the specific reporting fields that
you want to include in your report. To customize a report, first select Enable Interactivity on the report, as
shown in Figure 8.

Note: This choice is enabled by default.
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Figure 8) Customize reports with the Enable Interactivity function

e Events Storage ~ Protection ~ Jobs Reports

Report: Storage Summary &
Scheduled: No

J Enable Interactivity I

HA Pair N

Launch Viewer

fas8060-39-239/fas8060-39-241 A
Parameters

Table of Contents

Once interactivity has been enabled, you can customize your report to sort, filter, or delete a row or a
column from the report. When the customization is complete, you can save the modified report for future
reference or schedule it to run on a regular basis.

To customize a standard report, click any of the columns, as shown in Figure 9, to explore the available
features.

Figure 9) Options for customizing reports

Dashboard Events Storage - Protection - Jobs Reporis

9 11:15, 24 Mar: Cluster F2240-127-26_28 is not reachable and is no longer monitored. | Details |

Report: Storage Summary &

Scheduled: No
= Header 4
Cluster HA Pair T 1‘ = Group i Version
5] wdginffirclusD1 L Column b
wdginfilrelus01-01 iwdginfiirclus01-02 12
¥, Aggregation
5 clus_cpe-f3270-104-36-38-40-42 Y Filter P
3270-104-40/f3270-104-42 llsteam__8.3.0
13270-104-36/3270-104-38 t Sort ¥ lsteam_830
Alignment L
B F2z40-127-26 28 Aa Format 4
F2240-127-26/F2240-127-28 FASZZ90-5 &3RC1
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Enhance Standard Reports Example 1

This example describes the process to customize a report that highlights all volumes in the data center
that exceeded the Space Full Threshold. From the Report: Aggregate Capacity and Utilization page, as
shown in the following screenshot, click Run Report. Then perform the following steps to get your desired
report:

1) To remowve grouping by cluster or HA pair, follow these steps:
a) Click the column to be ungrouped (in this case, the Cluster and HA Pair columns)
b) Click. s

c) Select Group - Delete Inner Group.

Report: Aggregate Capacity and Utilization &

Scheduled: No
Cluster SRAl_ LA Dk, Aggregate Total Data Capacity (GB) Used Data Capacity (GB) Used Data %
——— N
B wht-8020-151-49- Header
I8! Group ’ Delete Inner Group
X Column 4 Page Break 707.66 67335 95.18
Hide Detail 707.66 673.36 95.15
Y. Aggregation
wfit_8020_151_49_aggri 8,938.85 5,084.7 56.88
$ sort 5 wfit_8020_151_51_aggr1 8,938.85 7,039.79 78.75
0
19,293.02 13.471.21 69.82
Alignment 4
19,293.02 13,471.21 69.82
Aa Format 4
= system1_taas
Export Content
aggr0_nst_fas6280_3_0 715.54 680.87 95.15
aggr0_nst_fas6280_4_0 715.54 680.88 95.15
Aggr_nst_fas6280_4_1 17,323.71 16,423.98 94.81
Aggr_nst_fas6280_3_1 17,323.71 16,665.26 96.20
R NTAR 24 ARN QO QF 40

2) To display the difference between Space Full Threshold % and Available Data %, add a new column,
as shown in the following screenshot

a) Selectthe columnand click. ===

b) Select Column - New Computed Column.

¢) Inthe New Computed Column dialog box, enter a column label.
d) From the Select Category list, select Math.

e) From the Select Function list, select DIFFERENCE.

f)  From the Column 1 list, select Space Full Threshold (%).

g) From the Column 2 list, select Used Data (%).

h) Click OK.
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3

4)

5)

6)

7

8)

9)

17

agl

agt

New Computed Column
Column Label: Space Full Threshold Breached
Select Category: Math i
: Advanced... A
Select Function: ADD Ml
ABS
CELING

Mmoo
DDANLICT

DIFFERENCE, Column2 - Columni

Calculates the difference, number2 - numbe

Columni: Space Full Threshold (%)

Column2: Available Data %

Cancel m

To filter values greater than 0 in the new column, click the New Computed column and then click
y toopen Filter dialog box.

From the Condition drop-down list, select Greater Than.

In the Value field, enter 0 and click OK.

To sort the values, click the New Computed column and then click

Select Filter > Top/Bottom N.

T

In the Top/Bottom N dialog box, select Top N from the Filter field and enter a value in the text field.

Click OK.

OnCommand Unified Manager Reporting for
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The following screenshot shows the new report that now includes the volumes that breached the Space
Full Threshold. Save this report with a new name to differentiate it from the standard report included in
the OnCommand Unified Manager library.

Report: Aggregate Capacity and Utilization &

Manage Report Schedules

Actions ~ Refresh

Scheduled: No
= 1/4 b P»l
Space Ful
Cluster HA Pair Aggregate Total Data Capacity (GB) Used Data % Available Data % Space Full Threshold (%) Threshold
Breached
= =
Wit-8020-151-49-51 S1-49MMt-8020- 000 wiit_8020_151.49.0 707.66 95.15 485 % -85.15
Wht-8020-151-49-51 S1-49MM-8020- .00 wiit_8020_151_51_0 707.66 9515 485 %0 8515
wit-8020-151-48-51 0-151-49Mf-8020- & 8000 151_49_aggri 893885 5588 4312 %0 4588
wit-8020-151-49-51 Wit 8020-151-49MMt-8020-  wiw_8020_151_51_aggrt 8,938.85 7875 2125 % 68.75
system1_taas 25("35625&3/"5("656:55“ aggr0_nst_fas6280_3_0 715.54 85.15
systemi_taas Nstfas6280-3inst-18s6280-  agqr0_nst_fas6280_4_0 71554 851
system1_taas stfas6260-3inst1as6280-  aggr_nst_fas6280 4.1 17,3237 mes -84.81
nst-fas6280-3/nst-fas6280- w\m\""“
system1_taas it b it Aggr_nst_fas6280_3_1 17,323.71 N \1\\\’35 3 852
5 1-24n-8060-06/nst-24: co‘“Spaw o s ad
. nst-24n- inst-24n- ;i < -85.
system1_taas Lgas aggr0_system1_taas_05_0 707.66 g‘ea"'“ed _ 85.1
nst-24n-8060-06/nst-24n- ; "
system?_taas s agar0_system_tass_04_0 707.66 8515
system1_taas gégé‘ggeoemwm-mn- Aggr_nst_24n_8080_05_1 16,387.89 76.06
systemi_taas net 24n-8060-06/nst-241-  pggr_nst_24n_8060_06_1 21,602.22 6763
system1_taas 3t 2 Je0 OmbAn: 300r0_system1_taas_06_0 707.66 95.15 485 % 8515
system1_taas g§§;§41rge-oso-05/nst-:4n- aggr0_system1_taas_07_0 707,66 9516 484 %0 85.16
svstem! taas nsk:24n-8060-00/nst-24n-  agar nst 24n 8060 101 2458183 67.81 3219 %0 sza1 |™

Similarly, you can customize multiple reports from the standard reports to suit your specific requirements.
The following are typical scenarios that you can customize:

a) Listing top aggregates that are reaching their full capacity

b) Listing aggregates with overcommitted threshold breached

c) Listing NetApp SnaplLock® compliance volumes

d) Top gtrees that breached soft limits

e) Listing events with a sewerity type

f) Listing most critical events

g) Listing nodes that are breaching the maximum nodes limit

h) Listing volumes with inaccessible junction paths

i) Listing volumes with default export policy

j) Data protection reports based on schedules on which they are run
k) Data protection volumes grouped by the timelines by which they are triggered, etc.

[) ...and many more.
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Enhance Standard Reports Example 2

This example describes the process to create a simple volume report using filtering to select volumes that
reached 85% to 95% of capacity. The following steps show how to use color in contextual formatting and
in removing the grouping from the standard report:

1) Goto the Reports tab and run the following report:

NetApp OnCommand Unified Manager Help ~ | Administration ~ | Usert - | Sign Out
. Events Storage Protection = Jobs Reports Al v | Search | Q |
Reports € import Report | | Manage Report Sthedules | Visit Online Automation Stare Collapse All

[=] capacity utilization

Storage Summary Run Report

Analyze storage capacity and utilization of your storage system to quickly understand key areas such as capacity risks, and availability trends.

Aggregate Capacity and Utilization ‘ Run Report |

Analyze aggregates capacity and utilization in a cluster to understand possible capacity risks and to view the configured, used, and unused capacity of aggregates.

Volume Capacity and Utilization ‘ Run Report |

Analyze volume capacity and utilization in a cluster to understand possible capacity risks and to make decisions about enabling space-saving features such as deduplication, thin provisioning, and
so on.

Qtree Capacity and Utilization

Run Report

Analyze capacity and utilization of the system's gtrees to understand possible risks that might occur due to reduced cluster capacity.

2) Doing so takes you to the report:

NetApp OnCommand Unified Manager Help - | Administration - | Userd - | Sign Out
. Events Storage ~ Protection - Jobs Reports Al v | Search Q.
Report: Volume Capacity and Utilization & Manage Report Schedules | | | Actions = | | Refresh |
Scheduled: No
= 1/38 b M
Cluster Storage Virtual Machine Volume Total Data Capacity (5B)  Used Data Capacity (GB) USB(U
() wit-8020-151-49-51
B wso
xedr_vs_1_vs_1_vol_12_DP1 556.32 31358
xedr_vs_1_ws_1_vol_12_XDP1 587.71 31538
xedr_vs_1_vs_1_vol_2_DP1 855.00 668.40
testvolume 1024.00 0.00

3) To remowve a grouping by cluster or HA pair and SVM(s), perform the following steps on the Cluster
and Storage Virtual Machine columns:

a) Click inthe columnto be ungrouped (the Cluster and Storage Virtual Machine columns in this
case)

b) Click
c) Select Group > Delete Inner Group.
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4) Delete all the columns you want to remowve from the report:

Report: Volume Capacity and Utilization & | Manage Report Schedules | | Actions | | Refresh |

Scheduled: No

= 1/38 b D
wity (GB) Used Data Capacity (GB) Used Data % Available Data Capacity (GB) e Dlodo 01 Dicibs Cee Wb aes Days To Full
Header 4 -l
| Group Y Add Group
s5e.32 a12s8 618 24474 I Column ' Delete Inner Group
587.71 315.38 53.66 27233 Page Break
Aggregation T
855.00 668.40 78.18 186.60 Z Aggreg |
Y Filter 4
1024.00 0.00 0.00 1024.00 ) 165,983,980
900.00 860.42 95.60 39.58 |
$ Ssort 4
S00.00 65266 76.96 207.34 !
Alignment 4
855.00 576.14 67.39 278.86 ! v
4 Aa Format 4 3

5) The report now displays the cluster and SVM information and the required fields.

Events Storage ~ Jabs Reports Al v | Search Q|
Custom Report: Custom Conditional Formatting Example (. Manage Report Sche
Cluster Storage Virtual Machine Volume Total Data Capacity (GB) Used Data Capacity (GB) Used Data % Available Data Capacity (GB) Available Data %
nst-fasB0B0-max-1-2 vs_max_003 vs_D03_vol_015 572.80 676.51 69.54 286.29 30.45
nst-fasE080-max-1-2 vs_max_024 ws_024_vol 013 95.00 0.04 0.05 9495 92,95
nst-fas8080-max-1-2 vs_max_003 vs_003_vol_011 972.80 668.63 6873 30417 N7
nst-fasB0BD-max-1-2 vs_max_020 vs_020_vol_006 5.00 0.04 0.04 9495 9.9
nst-fasB080-max-1-2 vs_max_028 ws_028_vol 011 972.80 237.52 24.42 735.28 7558
nst-fasB080-max-1-2 vs_max_018 vs_018_vol 010 §72.80 645.24 66.33 327.56 3367
nst-fasB080-max-1-2 vs_max_020 vs_020_vol_003 95.00 0.04 0.04 9495 9.9
nst-fasB080-max-1-2 vs_max_031 ws_031_vol 005 972.80 148.01 15.21 82479 84.79
nst-fas8080-max-1-2 vs_max_034 vs_034_vol_014 95.00 75.67 79.67 1913 2013
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6) Perform the following steps to create conditional filtering on the Used Data% column:

Ty

B) Used Data © Header * | Avaisble Data % | Daily Growth Rate %

1 50.5 Group 4 30.45 2.96

o o0 I Column v 58,95 263

33 687 31.27 234

7 0g XL Aggregation 59.96 235

52 244 Y Filter ’ 7558 207

P 85.3 33,57 2.05
{1 sort 4

M 0.0 59.95 2.05
Alicnment .4

N 15. A4 TG 204
A »

e TS Copy Style )

Export Content 3 Conditi IE thi
3 71.4 onditional Formattin a0
A -

4 0.05 94,55 = Format Data 83

29 16.07 816.51 Copy Format 78

32 £7.81 313.18 3219 178

7) Onthe conditional formatting window, select Column Name, Condition, and Value (for used data %):

i R T
Conditional Formatting X
Selected Column: Used Data %
Delete Rule
Format Preview
1
Column Mame: | Used Data % -
Condition: Greater Than or Equal to TS 2
Value: | ?,5| |gh=-- ~Valug
Add Rule
Cancel m
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8) Add a colorto the conditional value (that is, any volume with a used data percentage greater than or
equal to 85%). This example, uses yellow to highlight the volumes that match this criteria.

Note: You can select either a font color or a background color.

" “Ised Data % Avails

5054
Selected Column: Used Data %o 0.0s
Font X
Format
Column Name: | Used Data % . Font: Sz
| Auto ~ | | Auto @
Condition: Greater Than ¢
Value: 25 Color: ~ Background Color:
RGE(255,204.0) | Auto -
Auto
Basic Colors
, HEEEEEEN
EENNEENEN
HEEEEEERN
EEREEECN
EEEREROO Cancel
OO0NmO
To0.81 81.20
‘3 Custom Colors | |
9) To complete task, click Add Rule and OK in the Conditional Formatting.
Conditional Formatting X

Selected Column: Used Data %

Delete Bule

Format
Column Name: | Used Data % -
Condition: Greater Than or Equal to N
Value; #5 Change Value
Add Rule
Cancel
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10) If you want to create additional rules, repeat steps 7 and 8 with the condition “Greater Than or Equal
t0 95%” and add red to this value, as shown in step 9.

Conditional Formatting

Selected Column: Used Data %o

Delete Rule
Format
Column Mame: | Used Data % -
Condition: Greater Than or Equal to >
Value: a5 ChangeValue

Delete Bule

| Column Mame: | Used Data % -
Condition: Greater Than or Equal to -
Value: a5 Change Value
1 Add Bule
2 _|E3

Click OK to complete all the steps.
Note: The values in the example are differentiated by background color.

11) Figure 10 shows the report with the selected color-coded values for Used Data %.
Note:
o The example uses yellow for values >=75% and red for values >=85%. You can customize these
colors and percentages to suit your requirements.

e You can sawe the report with a new name, schedule the report, or export the new report to an
email address, as explained earlier.
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Figure 10) Example of custom conditional formatting.

Custom Report: Custom Cenditional Fermatting Example Manage Report Schedules

Scheduled: No

Yt
Cluster Storage Virtual Mac hine Volume Total Data Capacity (GEB) Used Data Capacity (GB) Used Data % Available Data Capacity (GB)
i DE_vserver etr_redo_v2037 950 s0c | SN 1.42
wiit-25 vs_2 wiit_max_wvol_test_179 2520 2142 84.98 379
vs_max_025 ws_025_vol 004 972.80 826.20 8493 14580
wifit_2552_151_41_43_data_vs1 vol_replay_cache_nfs_7 0.58 0.49 84.93 0.09
vs_2 wiit_max_vvol_test_156 355 3.02 84.89 D54
wiit_2552_151_41_43 data_vs1 wvol_replay_cache_nfs_& 065 0.55 8487 010
vs_1 wifit_max_vvol_test_2 85.31 7240 84,87 12.90

vs_2 wiit_max_vol_test_182 3935 2335 8475
vs_2 wifit_max_vvol_test 285_ondemand_clone_ondemand_clone 262 222 84.74 0.40
wiit-8020-151-48-51 vs0 xedr_vs_1_vs_1_vol_20_XDP1_0 1021.47 865.43 8472 156.04

8 Custom Reports

To build a new custom report, you need the following:

e Afully operational OnCommand Unified Manager server
e An Eclipse-based tool installed on a separate system to design reports using simple SQL queries

8.1 Software Requirements

To produce feature-rich custom reports, you can apply the open-source Eclipse tool or the OpenText
Actuate Analytics Designer.

To install the Eclipse todl, use either of these links:

e Eclipse IDE for Java and report developers:
http://www. eclipse.org/downloads/packages/eclipse-ide-java-and-report-developers/marsr

e “All-in-one” package: http://download.eclipse.org/birt/downloads/

Note: Eclipse can be installed on Windows, Mac OS X, and Linux operating systems. To set up and
configure the designer of your choice, follow the installation instructions for the software.

To download the OpenText Actuate Analytics Designer, go to:

e http://birt.actuate.com/products/analytics -designers/analytics-designer
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Note: The Eclipse tool is an open source free IDE. If you prefer the professional version, you need to
procure the license yourself. For Unified Manager reporting, the open source version satisfies most of
your needs.

8.2 Eclipse Prerequisites

Eclipse requires a connection to the Unified Manager database, using Port 3306 to connect through a
JDBC connector and a database user for authorization.

To create a database user in the Unified Manager senver:
1. Login to Unified Manager as the OnCommand administrator.

2. Navigate to Administration - Manage Users.

3. Click Add and add a database user with Report Schema as the role definition.

Add User e

Database users with the Report Schema role, have read-only
permissions to access report-specific database views directly from
the database.

Type: | Database User

Name: dbuser
Password:  «eeess

Confirm Password: | sesess

Role: | Report Schema

Add Cancel
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8.3 Creating Custom Reports with Eclipse

The workflow shown in Figure 11 is a basic guide to creating your custom report.

Figure 11) Workflow to create custom reportwith Eclipse

Launch Eclipse tool

Create a report project

Create a Reportfile and add to
the report project

Create a data source

Keyin
connection
parametersonly
once

Create orselect connection
profile

Create dataset

Format and style your report

Save and publish
report
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Create a Report Project

The following steps describe how to create a new report using Windows after Eclipse is set up on a
separate system (as described in Section 8.1 Software Requirements). The Linux and Mac OS Xwversions

follow similar procedures.

1. Login tothe system thatis hosting Eclipse and open the application.

2. Change the view to the Report Design perspective. Select Window - Open Perspective = Report

Design.

= Report Design - C:4User s Administrator,workspace' test_project’, .project - Eclipse

i SEREAE

[8 DataExplorer 53

& data view is not available,
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File Edit Mawvigate Search Project Fun Design | Window  Help

Q-

Mew Window
Editar
Hide Toolbar

roject &3 disk_invenkor

Open Perspective

Shio Yig

B Feport Design

Cusktamize Perspective. ..
Save Perspective As. ..

projectDescription

Reset Perspective... [e] name
Close Perspective [e] comment
Close &l Perspectives [e] projects

[2] buildspec
Mawigation L [€] natures
Preferences
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3. To create a new project, navigate to File > New - Project. The following screen appears.

= New Report Project !E
Report Project 2

Project name must be specified =C

Project name: | |

W Use defaulk location

Location: | Clilserst administratoriwaorkspace. pgh Browse. ., |
Choose file system: IdeFauIt "'l

=
',3:.' < Back ek = | Finish I Canicel

4. In the wizard, click New Report Project and click Next.

= Report Design - CUsers', Administrator,workspaceh test_project’,.project

File Edit Mawvigate Search Project Run  Design  ‘Window Help
Alt+Shift+M » B Froject...
Cpen File. ..
7 Folder
lose Chrl |=—j Repork
Close Al Chrleshifte = 0
@ Template
Save ZErl+5 fiif Library ]
|5l Save As.., |
= Example... |
Save Al Chl+Shift+s b
Revert 4 Other,.. Ctrl+M
(=X =
Hename, .. F&
DaFrach (==
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5. Onthe Eclipse launch page, create a new project. Navigate to New Project - Report Project and
then click Next. Provide a name for the project and click Finish.

806 New Project

Select a wizard —>

Create a new Report Project.

Wizards:
type filter text

p (= General

¥ (= Business Intelligence and Reporting Tools
|& ODA Designer Plug-in Project
.u_, ODA Runtime Driver Plug-in Project

P (= CVS

» (= Eclipse Modeling Framework

> (=EB

P (= Java

» (= Java EE

> (= JavaScript

b (= JAXB

> = JPA

» (= Plug-in Development

@ < Back m |  Cancel | Finish

6. Provide a new name for the project and then click Finish. Either use the default location for storing
your reports or specify the desired location by deselecting the checkbox.

= MNew Report Projeck !E[
Report Project _

Create a new report project, =

Project name: | Derno F‘roject|

V¥ Use default location

Location; |C:'I,Llsers'l,.ﬁ.dministrator'l,workspace.pgb'l,Demo Project Browse. . |

Choase file systen: Idefault 'l

® < Back [dext = | Finish I Cancel
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Create a Report File

1. To create a new report under a project, click File > New > Report.

8006

New

Select a wizard

This wizard creates a new Report from a predefined template.

Wizards:
type filter text

P (= General

¥ =~ Business Intelligence and Reporting Tools

il Library
[£" ODA Designer Plug-in Project
ODA Runtime Driver Plug-in Project
Report
Report Project
=] Template
» = Connection Profiles
(= CVs
P (= Database Web Services
¥ = Eclipse Modeling Framework
> (= EB
» (= Java

Cancel

Finish

Alternatively, right-click the new project and select New = Report.

= Report Design - pgb1/.project - Eclipse

File  Edit

O -

Mavigate

Open
Open wWith

il 1 Project..,

» (7 Folder

[2 Data Explorer & [Z Capy

A data view is not ay Paste

9€ Delete
Mawe, .
Rename. ..

B Report
Template

i Library

1 Example. ..

Chrl+r

= Import,..

(i Export..,

[ Other...

[€] comment
[8] projects

| Refresh

(8] buildspec

Yalidake

Show in Remote Systems view
Profile As

Debug As

Run &z

Team

Replace With

IPA Tools

Compare With

Source

(8] natures

* ¥ ¥F Fr v wv wr

Properties

To Mavigator £2
Remaye fram Combext

] .
E‘ [{_/ Dema Proje MMark as Landmark

CErlH-AlE+ Shifb Do
Chrl-AlE+ShifEHUD
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2. Select the report project name to store your report. For this demo, we selected Demo Project, as
created in the previous section. Provide a name for the new report and click Next.

= Mew Report = @
Report -
Create a new report, =0

Enter or select the parent folder:

Dermo Project

— 19
. [ Insight Demo
(¥ Protection
= RemoteSystemsTempFiles
% sample
(% sample project

File nameq new_repart.rptdesign|

@' < Back ’ et » ] [ Finish ] ’ Cancel

3. The next page of the New Report dialog box presents a selection of report templates. Select the
type of template to create and then click Finish.

= New Report [o (&=

Report -
Choose the type of report you want to create, =0
Report templates: Prewviews:

4 @ Standard
a Blank Report
a My First Report
a Simple Listing
a Grouped Listing
a Dual Colurmn Listing
a Dual Column Chart & Listing
a Side by Side Chart & Listing
B Chart & Listing
a Cross Tab

Date

Description:

Create a blank report with no
predefined content,

Showe Report Creation Cheat Sheet

@' [t = Finish ] ’ Cancel
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Create a Data Source

BIRT reports use a data source element to connect to the OnCommand Unified Manager database and to
guery and retrieve data from the data provider.

1. Open the Data Explorer view.

2. Select the Data Source node from the tree. Right-click Data Source and select New Data Source fom
the drop-down menu:

: @-Q-o9- e

[8 DataExplorer 52 ==

& Data 5 Mew Data Source Step 2
[ DataC =
i [£3 Reportere

------ ([ variables

Paste

o Mavigator 52 COutline | = \§V| |
SR Project

- X project Step 1

new_treport.rptdes.,.

EI---L;“» pgbl

(55 Rennrts

3. Select Create from a Data Source Type in the Following List and then select JDBC Data Source from
the drop-down menu. Enter a name in the Data Source Name field. Click Next.

= New Data Source [_[Ol=]

Select a Data Source Type or Choose a Connection Profile.

Provide all the settings For a new data source, or choose & pre-defined connection profile.

-

If: Create from a data source bype in the Following list I

1 Create from a conneckion profile in Ehe pratile store

“assandra Scripted Data Source
lassic Models Inc. Sample Database
Excel Data Source

Flat File Data Source

Hive Data Source

POIO Data Source
Scripted Data Source
Web Services Data Source

“ML Data Source

Data Source MName: |New Data Source| e i @ i e e

=
|“?) < Back I Mext = I Finiishy Cancel
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Note: If you already created a connection profile, you can select Create from a Connection Profile
in the Profile Store. For details about the benefits and use of a connection profile, see Section
9.1 Connection Profile.

4. Provide the database URL (replace the IP here with the FQDN/IP of Unified Manager), user

name, and password from Section 8.2 Eclipse Prerequisites. In addition, enter the following
information:

¢ To add the database driver click the Manage Drivers button. Select the mysgl-
connector-java-*-bin. jar file that is available to you.

e Driver Class: com.mysqgl .jdbc.Driver (v5.1).This name is available as a drop-down
selection.

e Database URL: jdbc:mysqgl://<ip address of OCUM
server>:3306/ocum report

e User Name: The name of the database user that was created in the Unified Manager server
for the BIRT designer.

e Password: The password of the database user.

= New IDBC Data Source Profile M=
Create a new data source —

Create a new data source,

Driver Class: om. mysgl. jdbe. Driver {+5.1)) j =
Database URL: I jdbeimysqgl: /10,238,221, 200: 3306/ ocum_report

User Mame: I birtuser

Password: Ioooooooo

INDI URL: |

Manage Drivers... | Test Conneckion.., | Bidi Settings...

=l
li?) < Back. Mext = I Finish I Cancel

Note:

e Youdo not need tofill in the INDI URL field.

¢ Click Test Connection tovalidate a successful connection to the OnCommand Unified Manager
database. Then click Finish.

e Youcanuse the FQDN instead of the IP address for the database URL.
e Foran IPv6 address, the Database URL field should be in the following format:

Jdbc:mysql ://address=(protocol=tcp) (host=fd20:8ble:0255:8477:42f:11e:64e3:
5338) (port=3306) /ocum report

Where host=£d20:8ble:b255:8477:42f:11e:64e3:5338 is the host IPv6 address.
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Create a Dataset

With the database connection established between the Eclipse designer and the OnCommand Unified
Manager database, you are ready to create the report logic. The report logic is created in the Eclipse
editor by using simple SQL queries. Advanced users can use MySQL Workbench to create queries and
paste in the Eclipse dataset.

The following steps guide you through creating a dataset and SQL queries:

1. Nawvgate to Data Explorer - Data Set and click New Data Set.

&= Report Design - Demo Project/new_report.rptdesign - Eclipse
File Edit Insert Element Daka Page Mavigake Search Project Runm %

- R @ Q- S

[§ DataExplarer 53 =0

El-Lf Data Sources
‘[ Demo Data Source

Mew Draka Sek
Mew Joink Data Set

2. Select the data source created in the earlier section and then:
a. Select SQL Select Query from the Data Set Type drop-down menu.

b. Enter a name under Data Set Name.

c. Click Next.
New Data Set ‘--l
Define the data set's name, source, and type LL,

[~ Data Source Selection

bype Filter text

=R

Data Set Type:
[5cL select query |
Data St Mame:

[Data Set

Y
@) < Bark | et = | Finish Cancel

3. In SQL query window that opens, define a SQL query for the report that you want to produce. To
create a query, use the fields from the Available Items on the left-hand side. Expand an item to use
the fields that are available under that item.

Alternatively, drag and drop the Unified Manager database table fields (available under “Available
ltems”) to create your logic.
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eno Edit Data Set - disk-query

Data Source Define a sql query text using available items.

Query

Output Columns - . -

Computed Columns Available kems: Query Text:

Parameters v ) jabe 1select disk.nome, cluster.name, clusternode.name,
Filters » [Eaggregate 2disk.model, disk.containerType, disk.interfaceType
Property Binding » Brannotation 3 from disk

4 inner join cluster on disk.clusterld = cluster.id

i
:::vi’xuesulu :;:::::x:xl S inner join clusternode on disk.ownerNodeld = clusternode.id
» B cluster
» @ clusternode
» [hdisk

» [ diskaggregatemapping
» W exportpolicy
» @ exportrule

When you complete your selections, click Finish to view the results.

Note: If an incorrect query syntax or logic statement is submitted, an error occurs and the you are
alerted with a pop-up message.

4. Select the output columns youwant to include in the report and then click OK.

e .00 Edit Data Set - Data Set
Data Source Output Columns vy
Query =
Output Columns Define output columns:
Computed Columns
Parameters Name Type Alias Display Name Display Name Key [ edit... |
Filters name String name e
Property Binding type String type
Settings resourceld Decimal resourceld
Preview Results resourceType String resourceType

@ [ cancel | [okad

5. Drag the columns from the Data Sets to the Detail Row in the order that you want them displayed.

%2 Palette [8 Data Explorer 52 it Resource Explorer B, protection_... &2

= Data Sources -
4 @ Data Sets
4 S Data Set Protection
B destinationVolumeName
W destinationVserverName.
W isHealthy
B IagDuration
B lagatus
B IsstTransfeDurstion

Relotionship  Relationship Stete | selationshipStatus | Status LegStatus | Relationship Type  Sousce SVM. Source Volume | DestinationSVM | D
Health

[isHealthy) [lagStatus) ype] [ N ] -] (8]

R 4

B lostTransferSize
B ovenliStatus 4
B relstionshipState o~
W relationshipStatus ‘
B relstionshipType ’ 3
B scheduleName
B snapMinorPolicyame
B sourceVolumeName
B sourceVserveiName
Tits Cubes
& Report Parameters

Drag and drop all the data set items to prepare
Custom Report

- Varisbles
. Navigator 22 Outline =g
“HR=R-
b & s
(2 templates
4 [ themes - . '
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6. After you sawe the query, you can review the output by using a browser. Select the report in the
bottom left-hand corner and select Run - View Report > As HTML.

= Report Design - pgb1 /basic_DP_status.rptdesign - Eclipse
File Edt Insert Element Data Page Navigate Search Project | Run Window Help

1 1o B NN, = R . %] Debug Report | =[x
% view Report ld () In Web Yiewer
8 Data Explorer 53 “ () Generate Document W fis DOC
#-[f Data Sources ¥l A5 DOC,
= = L As HTML
B volumeRfaIat?Dnship - 5 a5 0DP
g ges:!na:!on Elu;ter o 2 as 0DS
estination Node
- Heatth £
As ODT
- [E Destination Volurne R GIJ =
- Destination SyM - [Haaltn : . A5 PDF
- Health Status o ¢l As POSTSCRIPT
B Health - [Hea =7l As PPT
B L : {of AsPPT
[ State - el
St : g As BLS_SPUDSOFT
- B Source Cluster . Thy e
- B Source Mode r i AsELSK
- [ Source Yolume )
- B Source WM
----- [ Data Cubes -
----- [£3 Report Parameters B
----- (& Variables -
I
T Mavigator 52 EE Outline = /‘5‘) = = 08 N

SX -2 Dema Project
i .projeck

7. To import this report into OnCommand Unified Manager, locate the new report.rptdesign file
(normally located in the workspace location defined during installation of Eclipse). Copy this file to a
system that can browse Unified Manager using the importing function explained in Section 9
Portability of Custom Reports.

Note: The custom reports, once saved, have * . rptdesign extensions in their file names.

8.4 Expanded Customization Using Format and Style

Eclipse Designer Ul Functions

A wide range of style and formatting functions is available with the Eclipse tool. This section describes the
basic Ul functions.

Layout Editor
The Layout Editor is the central area in which report designs are created. The editor has five tabs:

e Layout. Edit report design.

e Preview. Run reports and show output.

e Script. Add JavaScript to reports to customize their behavior.
e XML Source. View and modify the XML source of a report.

e Master Page. Format page data such as page headers.
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Views

e Palette. BIRT view shows the standard report items that can be added to your report using drag and
drop.

e Outline. BIRT view that shows the structure of your report as a tree view.

¢ Navigator. Standard Eclipse view that shows your projects and the reports within your projects.

e Data Explorer. BIRT view that shows your data sources (connections), datasets (queries), and report
parameters. You also use this view to add dataset columns to your report layout.

e Property Editor. BIRT view that displays properties for many report items. It has tabs and groupings
that organize properties into categories.

e Properties View. Standard Eclipse view that shows all properties for a report item as a simple list.

Format and Style

Once you create the report logic (SQL queries), as explained in step 4 of Create New Data Set, you can
use formatting to further customize by charting the data points. The following figures describe some of the
basic functions.

Figure 12) Drag-and-drop fields from the dataset to create tables

<% Palette 8 Data Explorer 52 | fiif Resource Explorer = O [ EfficiencyR.. X project [ protection_.. 53 [, cifs_report. X project ), test_report UM_report_ch, “history.rp.. » =0

» @@ Data Sources -

4 i Data Sets

4 Data Set_Protection
B destinationVolumeName
B destinationVserverName i
B isHealthy i [isHealthy]  [relationshipState] | [rel i [overaliStatus] ] [relati Type] [sourceV ] [source Name] [d erv..] [d]
B 'agDuration bl F

B lagStatus .

B lastTransferDuration i

B lastTransferSize -

B overaliStatus 5 L

B relationshipState PY
B relationshipStatus ‘
B rebationshipType " 3
B scheduleName

B snapMirrorPolicyName
B sourceVolumeName
B sourceVserverName

& Data Cubes
& Report Parameters

ip State i Status LagStatus  Relationship Type Source SVM Source Volume Destination 3VM D

n

Drag and drop all the data set items to prepare
Custom Report

= Variables i -
& Navigator 83 (= Outline =0 |3
| BB|e v
b [ scripts
» (= templates i -
4 (= themes - 5 it ¥
o~ - - T

Figure 13) Create charts using functions in the Palette tab

> Palette 52 [§ DataExplorer fiii Resource Explorer = £ EfficiencyR.. X project B protection_... 32 [ c

[3; Pointer Select

{2, Rectangle Select

= Report Items ol - Relationship State i Status LagStatus  Relationship Type Source SVM Source Volume Destination 35VM D

W Label
Aa Text
Dynamic Text
£ Data
@) Image
H 6Grid De’"ﬂﬂsrrare .
S A Sy C“an?nz.'ep"é’rfngi’i i iabuar formay g
[ Table . functions egc With cross tap
[i] Chart \
[ Cross Tab

& Quick Tools
Y. Aggregation
W1, Relative Time Period

Health
[isHealthy]

inType] [sourceV ] [source ] i erv.] [d

- Navigator 82 D+ Outline

> (2 scripts -
b (> templates

i ] »
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Figure 14) Format fonts and captions for charts created

- Navigator 32 Outline 20 |3
= seripts -
(= templates
4 (= themes = M
D reports_theme.rptlibrary Layout | Master Page | Script| XML Source
n ThemesReportltems.rptlibrary
[ ThemesReportiterns3.rptlibrary & Property Editor - Report 53 |* Problems € Enor Log
) ThemesReportiters3Lrptiibrary o
[E] um_reports.css {HREIE
X] .project Genéeral Seneral
=) builtin-events-messages.properties e
D history.rptdesign Description reated by: Eclipse BIRT Designer Version 4.5.0.+201506092134 Build <@BUILD@ >
[ test_report.rptdesign =| | Comments Path: Ci\Eclipseteclipse\eclipse\workspace\Protection\protection_relationships.rptdesign
4 2 Protection User Properties Title:
é .pfroject Named Expressions
rt.rptd:
U ole e U - Resources Themes: None T
M protection_relationships.rptdesign
4 % sample Event Handler eport Orientation: | Left To Right ~
X| .project Advanced isplay MName:
4 =2 Sample project —
X project humbnail: ftemplates/blank_report.gif ;‘

9 Portability of Custom Reports

Custom reports, created with the Eclipse designer, can be imported between environments. This
capability enables you to seamlessly import a report file (. rptdesign) created in Unified Manager
instance A to Unified Manager instance B.

Note: The methods for importing files are different for Unified Manager 6.4 and 7.x.

9.1 Connection Profile

A connection profile contains the required connection property information to connect to a data source (in
this example, a Unified Manager database). With a connection profile, administrators are not required to
repeat the connection definitions or to add the required MySQL drivers multiple times for each “custom”
report created within a single Unified Manager instance. The administrator can also use connection
profiles to import external BIRT report files (. rptdesign) from another environment.

A connection profile is an XML file with an . acconnprofiles extension. A connection profile contains
the database connection-related data for BIRT run-time environments. Optionally, the entire contentin the
connection profile can be encrypted for additional security. The major components in a connection profile
are:

e Data source name

e Database sener class information

e Database URL that connects to the Unified Manager database

e Database user name and password to connect to the Unified Manager database

Advantages of Using a Connection Profile

With a connection profile, you can:

e Create the profile one time for multiple (or all of the) reports used in a Unified Manager instance and
its associated storage objects.

38 OnCommand Unified Manager Reporting for © 2018 NetApp, Inc. All rights reserved.
NetApp ONTAP



e Create multiple reports without having to reenter the connection parameters (database driver, user
name, and password), resulting in significant time savings.

e With a simple understanding of the connection profile, you can import the same report to multiple
Unified Manager instances (the same file name but different parameters).

e Encrypt content (optional).

Connection Profile Prerequisites

The following components are required to create a connection profile. These components can be
downloaded from the host where the Eclipse designer is installed:

e BIRT designer editor (Eclipse with a BIRT plug-in or Eclipse from Actuate).

¢ Fully operational Unified Manager server with a report user created.

e Downloaded mysgl-connector-java-*-bin. jar from the web. For optimal reporting solutions,
NetApp recommends the version mysgl-connector-java-5.1.26-bin. jar or higher. You can
download this version from http://downloads.mysgl.com/archives/c-j/.

Note: The Unified Manager server should be in the same network as that of the server that hosts the
BIRT designer or, at a minimum, it should have port 3306 allowed.

9.2 Creating a Connection Profile

Log in to the host where the Eclipse designer is installed. Follow these steps to create a connection
profile:

1. From the main menu, select File > New = Other.
2. Under Connection Profiles, select Connection Profile from the wizard and click Next.

=New 10O %]
Select a wizard

Create a connection profile

Wizards:

bype filker bext

[ General
= Business Inteligence and Reporting Taols

| »

» CVS

=

(=5 Database Web Services
(= Edlipse Modeling Framework, —
== EJB
= Java
=

=

=

=

» Java EE
=5 Java Emitter Templates
= Javascript

(= 18%EB |

G
'\?,' = Back I Mext = I Fimisti Cancel
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Select the connection profile type.
Enter a unique name for the connection profile type.

Under Connection Profile Types, select BIRT JDBC Data Source. Enter a name and a description
identifier for the datastore. Click Next.

= Mew Connection Profile =]

Connection Profile

Create an BIRT JDBC connection profile

— Connection Profile Types:

type filter text

& . -

|»

s e
LEBIRT JDBE Data Source

gBIRT Sample DB Data Source

4 DB2 For Linu:, UMLK, and Windows

B DBz For i5/03

E4 DBz For 2005

4 Derbry

gExcel Data Source —
EZFlat File Data Source

[ Generic 1DBC

EdHsoLne

[ Infarmix

E_glngres

[ J0BC Database Connection For Query Builder d

Mame:

I Demo-Project data store

Description {optional):

I Demo Project data storel

Gy
'\?/' = Back. I Mext = I Einish | Cancel I

Note: Make sure that you document the data source name. This information is extremely important from
areport portability perspective. If you need to import another report (an . rptdesign file from an
external BIRT server or from another environment), your BIRT sener must have the same data
source name while creating the connection profile.

6. Complete the required information in the wizard for your connection profile type. Provide the database
URL (replace the IP here with the FQDN/IP of Unified Manager), the user name, and the password
from Connection Profile Prerequisites. In addition, complete the following fields with this information:

a. Click the Manage Drivers button to add the dtabase driver. Select the available mysql -
connector-java-*-bin. jar file.

b. Driver Class: com.mysql.jdbc.Driver (\5.1). This name is available as a drop-down selection.
Database URL: jdbc:mysql://<ip address of Unified Manager senver>:3306/ocum_report.

d. User Name: The name of the database user that was created in the Unified Manager server for
the BIRT designer.

e. Password: The password of the database user.

Note: Foran IPW6 address, the Database URL field should be in the following format:
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Jjdbc:mysqgl://address=(protocol=tcp) (host=fd20:8ble:b255:8477:42f:11e
:64e3:5338) (port=3306) /ocum report

Where host=£fd20:8ble:b255:8477:42f:11e:64e3:5338 is the host IPv6 address.
7. The JDBC Data Source Profile window opens.

=New JIDBC Data Source Profile [_ O[]

Create a new data source

Create a new data source, |

Driver Class: j =
Database URL: | jdbcimysgl: /10,238,221, 200: 3306 ocum_teport
User Mame: I hirtuser
Password: I LTI
IMDT URL: |
Manage Drivers... | Tesk Connection... | Bidi Settings. ..
=]

® < Back Mext = | Finish I Cancel

9.3 Creating Reports Using Connection Profile
To create a report using a connection profile:

1. Select File > New > Report to create a new report in your report project
B (&) O Ne.w

Select a wizard

This wizard creates a new Report from a predefined template.

Wizards:
type filter text

P (= General
¥ (= Business Intelligence and Reporting Tools
il Library
[ ODA Designer Plug-in Project
‘n_, ODA Runtime Driver Plug-in Project
eport
o Report Project
d Template
» [=-Connection Profiles
P (=-CVS
P = Database Web Services
» (= Eclipse Modeling Framework

> (= EB
F (= Java
|
@ [ cancel | | Finish
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Alternatively, you can right-click the new project and select New - Report.

= Report Design - pgb1/.project - Eclipse

File  Edt avigat: [ roject...

. |_=f|' Cpen

: Cpen With
[8 DataExplorer [ copy

A data view is not a,

Faste

y (4 Folder
E:F pork
@ Template
i Library

2% Delete
Mave. ..

[ Example. ..

Rename...

[ Other...

Chrl+1

(e Import...

(g Expart...,

| Refresh

Yalidate

Show in Remote Systems view
Profile As

Debug As

Run &s

Team

Replace With

JPA Tools

Compare WWith

Source

r r r r v T T Tr

Properties

T Mavigakor 53
ChtlH-AlE-Shift-Davwn

CErl-A e+ ShifE-Up

Remayve from Context

MMark a5 Lamdmark

E---@ Derno Praje

[8] camment

[8] projects

(8] buildspec
[&] natures

2. Provide a name for the new report. You can use the default location to store all reports by selecting

the Use Default Location checkbox. Click Next.

Report

Create a new report.

Enter or select the parent folder:
[¥] Use Default Location

dfm-report-app/Report Designs

H
4 5] dfm-report-app
bin
idelib
Report Designs
> src
5. Examples for NetApp
Test2

Filename: Test_Reportl_Using_Connection_Profile.rptdesign

@ o I

Next > ][

Finish | |

Cancel
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3. Select the type of report from the report template; in this case, Blank Report. Click Finish.

x
=3
Choose the type of report you want to create. =
Report templates: Preview:
« @l Standard
[ Blank Report

B My First Report

B Simple Listing

B Grouped Listing

B Dual Column Listing

B Dual Column Chart & Listing
B Side by Side Chart & Listing
B Chart & Listing

B CrossTab

B UM_report_chart_listing

a UM _report_listing

Act
o)

4 i uate pate
Blank Auto Interactive Report S
Description:
Create a blank report with no
predefined content.

Show Report Creation Cheat Sheet

V] Include the default themes

@ Net> | () [maCmcin)

New Data Source =
Select a Data Source Type or Choose a Connection Profile. -
Provide all the settings for a new data source, or choose a pre-defined connection profile,

Create from a data source type in the following list

Create from a connection profile in the profile store

Actuate Data Object Data Source
Actuate Information Object Data Source
Actuate JDBC Salesforce.com Data Source
ActuateOne for e.Reports Data Source
Amazon DynamoDB Data Source
Amazon RDS Data Source

BIRT Report Document Data Source
Cassandra Scripted Data Source

Classic Models Inc. Sample Database
Cloudera Hive Data Source

Excel Data Source

Flat File Data Source

HBase Hive Data Source

Hive Data Source

JDBC Database Connection for Query Builder
JDBC Data Source

MeongoDB Data Source

POJO Data Source

Scripted Data Source

Static Data Source

Web Services Data Source

XML Data Source

Data Source Marne: | Data Source

<Back |[ New» ][ Anisn  |[  cancel
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5. Onthe Connection Profile screen, click New.

Select a Connection Profile

Select the connection profile from which to create a data source

Browse.. |~

Connection Profile Store:

[/] Use externalized properties in Connection Profile Store

Use the default data source name

Data Source Mame;

[ <Back | Nex> Finish | [ Concel |

6. Select your connection profile. In the Specify a File Name field, enter a file name and path to create a

profile at that location.
Note: This step is a one-time operation. After you take this step, you can always choose this file in

Step 5 by clicking Browse.

File extension(s) to display: .acconnprofiles

4 (& dfm-report-app
» & .settings
> (&> Report Designs
& bin
b & idelib
b & src

[V] Use the default data source name

Siles

Next > Finish Cancel

J

S T -
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7.

8. Click Next.

45
NetApp ONTAP

M @

In Create a Connection Profile Store, click OK.

-
%) Connection Profile = >

Select a Connection Profile

Select the connection profile from which to create a data source

Select the connection profiles to be included in the store:

a BIRT Classic Models Sample Database
B4 ocum_conn
@ ocumDb
[E] um_ds1
[E] us_dst

Specify a file name:  Report Designs/um_dsl_connection.acconnprofiles

Encrypt file content

| Browse... | =

Use the default data source name

Data Source Marme:

< Back ” Mext > | | Finish

| l Cancel

Select a Connection Profile

Select the connection profile from which to create a data source

Connection Profile Store: - Report Designs/um_ds1_connection.acconnprofiles

Use externalized properties in Connection Profile Store

EE
m
| N

4 ODA Data Sources
4 JDBC Data Source
um_dsl

Use the default data source name

[ata Source Mame; um_dsl

<Back | Net> || Finsh
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9. Afterthe process has finished, you can see the connection profile with . acconnprofiles in your

workplace, showing the datastore that was created.

%% Palette [§ Data Explorer 37§ Resource Explorer

4 mm Data Sources
| um_dsl|
i Data Sets
i Data Models and Data Cubes
i Report Parameters
i Variables

5= Qutline ©5. Navigator 52 = <‘}=='=>

4 |51 dfm-report-app
= bin
[ [= idelib
4 = Report Designs
b‘ Test_Reportl_Using_Cennection_Profile.rptdesign

o

| umn_dsl_connection.acconnprofiles

= 0

10. Now you can create a dataset with the desired query for the report. Click Next.

CTTRTFSpPr e

Bl brwen T

# D8 Dk vy
o

s e P
Tl Gy
[T r—

T j—

i
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11. Fill'in the query and click Finish.
_MeDaaset . R - s e e

Query
Define a sql query text using available items.

Available ltems: Query Text:
> [ aggregate | 1select aggregate.name, aggregate.state, aggregate.sizeTotal, aggregate.sizelsed
2from aggregate;|

» [ annotation

» [ annotationofclusterview
» FE1 annotationofvolumeview
> EE annotationofvserverview
> B cifsshare

> [ cifsshareacl

> B cluster

> T8 clusternode

> [ disk

- [ diskaggregatemapping

> [E exportpolicy

> [ exportrule

> (B fepport

> T Iif

> B8 lun

> (B networkport

» (B qtree

» [E] qreequota

- [E storagepool

- EE storagepoolaggregatemapping
> B svm L4

m

> [ svmaggregatemapping
> [E) userquota
> I volume

> I8 volu r ipvi 2
g

Filter:

Typer  [-All -

[] Show system tables
[7] Show alias

When adding selected items to SQL
7] Quote all identifiers

[#)Include schema in item name < :

Note:

e You should create the data source by using a connection profile.

e Do not provide a name for the data source.

e You should select the Use the Default Data Source Name checkbox.

e Create an encrypted connection profile. (This step is optional, in case youwant a secure method of
communication.)

e The . rptdesign file with a connection profile has the following lines under the Data Sources design
element. You can review the lines in bold to identify that the report is using a connection profile.

<property name="odaDriverClass">com.mysql.jdbc.Driver</property>

<property name="odaURL">jdbc:mysql://192.168.1.1:3306/ocum report</property>
<property name="odaUser">birtuser</property>

<encrypted-property name="odaPassword"
encryptionID="base64">bmV0YXBwMSE=</encrypted-property>

<property name="OdaConnProfileName">NtapReport</property>

<property
name="OdaConnProfileStorePath">Conn/ntap_conn.acconprofiles</property>
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Note: Foran IPv6 address, the database URL should be in the following format:

jdbc:mysqgl://address=(protocol=tcp) (host=£d20:8ble:b255:8477:42f:11e:64
e3:5338) (port=3306)/ocum report

Where host=£fd20:8ble:b255:8477:42f:11e:64e3:5338 is the host IPV6 address.

10 Importing Custom Reports

This section describes the steps required to import custom reports in Unified Manager 7.0 and 6.x
versions.

10.1 Importing Custom Reports in OnCommand Unified Manager 7.x

The OnCommand Unified Manager 7.0 report import feature is interactive and easy to use. With the
* _rptdesign file is running in the Unified Manager instance, perform the following steps:

1. Select the Reports tab. On the Reports page, click Import Report.

NetApp OnCommand Unified Manager

iy Events Storage ~ Protection = Jobs Reports Al v || Search

Reports & Import Report | | | Manage Report Schedules | Visit Online Automation Store

[=] capacity utiiization

Storage Summary Rur

Analyze storage capacity and utilization of your storage system to quickly understand key areas such as capacity risks, and availability trends.

2. In the Import Report window, enter the following details:
a) Select the customreport (* . rptdesign)file.
b) Enter the report name.
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c) Enter adescription for the report.

d) Select an existing Unified Manager database user with the “Report Schema” role and create a

new user.
Import Report & X
) Select Report File: Browse...
b O Name:

(O ptional) Select database user with report schema role

If you are importing reports from OnCommand Automation Store, then it is mandatory to select of the following.
When Mene is selected the user specified in the report file is used to import and run the report file.

& Mame: | pone w

d Create Mew User
sting Users —
birtuser

You can either select an
already created DB user with
report schema role (or) create
a new one here, instantly!

Cancel

3. Click import to import the report to your Unified Manager instance. You can schedule and/or further
customize the reports, similar to standard reports.

10.2 Importing Custom Reports in OnCommand Unified Manager 6.x

To import external report files (. rptdesign) into your environment:

e To start the import process, you must have a defined connection profile in your OnCommand Unified
Manager instance.

¢ You must have a separate connection profile for each Unified Manager instance. The same
connection profile cannot be used for multiple Unified Manager instances.

¢ Reports that are imported with or without connection profiles will stop working if:
— The report user is deleted.
— The report user password is changed in the Unified Manager sener.

— The Unified Manager server URL has changed (it must be the same URL that you used when you
created a data source profile; for example,
jdbc:mysqgl://192.168.1.1:3306/ocum report).

e Always keep a copy of the original . rptdesign file that you plan to import.

Note:

e You canreplace the IP address with the Unified Manager server FQDN in the database URL
field.

e Foran IPW6 address, the Database URL field should be in the following format:
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Jjdbc:mysqgl ://address=(protocol=tcp) (host=fd20:8ble:b255:8477:42f:11e:64
e3:5338) (port=3306)/ocum report

Where host=£fd20:8ble:b255:8477:42f:11e:64e3:5338 is the host IPV6 address.

Configuration Changes
To import an external . rptdesign file, you need to make a few configuration adjustments:

1. Login tothe Unified Manager instance and create a directory called Conn under the reports directory.
For Linux systems, the default location is /opt/netapp/ocum/reports/.

Note: For OnCommand Unified Manager seners that are deployed as vApp, log in to the server by
using root credentials.

Copy the connection profile that you created for this Unified Manager instance to the Conn directory.

Change the . rptdesign file contents to point to this connection profile location. (The following
example is from a Unified Manager instance thatis installed in Linux; you should find equivalent
information for Windows.)

From
<property
name="0daConnProfileStorePath">Conn/ntap conn.acconprofiles</property>

To

<property

name="0OdaConnProfileStorePath">/opt/netapp/ocum/reports/Conn/ntap conn.acconp
rofiles</property>

4. To confirm that the report is connected using the connection profile, remowve the following lines. These
lines are optional and are used by BIRT as a fallback mechanism if it cannot connect through the
connection profile:

<property name="odaDriverClass">com.mysql.jdbc.Driver</property>

<property name="odaURL">jdbc:mysql://192.168.1.1:3306/ocum report</property>

<property name="odaUser">birtuser</property>

<encrypted-property name="odaPassword" encryptionID="base64">bmVOYXBwMSE=</encrypted-property>

Note: Foran IPv6 address, the database URL should be in the following format:

Jjdbc:mysql ://address=(protocol=tcp) (host=fd20:8ble:b255:8477:42f:11e:64
€3:5338) (port=3306)/ocum_report

Where host=£fd20:8ble:b255:8477:42f:11e:64e3:5338 is the host IPv6 address.

5. Import the external . rptdesign file.
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11 What’s new with Unified Manager 7.3

11.1 Database Schemas Exposed with Unified Manager 7.3

Before Unified Manager 7.3, you could create custom reports with only one “read-only” schema —
ocum_reports. However, with Unified Manager 7.3, NetApp exposes all the schemas in Unified Manager
for external consumption. You can now view all the available objects monitored by Unified Manager and
create custom reports with any third-party tool that accepts a JDBC connection.

With Unified Manager 7.3, you get read-only access to most of the Unified Manager internal schemas
(including the Performance Schema).

Prerequisites

The procedure to connect to the Unified Manager senver is the same as described earlier in this
document; an existing reporting user (DB user with the 'Report Schema' role) is required to access all the
tables. Therefore you must create a DB user with 'Report Schema' permission from the Unified Manager
User's page. This user has only 'Read-Only' permission for all existing tables in the MySQL database.
Howewer, this user does not have permission to access any tables that hold user data or cluster
credential information.

11.2 Exposed Schemas

All tables for the schemas shown in Figure15 are exposed to this user with only the 'SELECT operation,
except for tables that contain cluster and DB credentials.

Figure 15) Schemas that are exposed to the user
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12 Different Ways to Extract Datafrom Unified Manager 7.3

With Unified Manager 7.3, you can export and extract Unified Manager data in several ways, as
described in this section.

12.1 BIRT

The built-in reports use BIRT integrated with Unified Manager to provide customizable reports as
explained in Section 7.2.

12.2 Open Database

Users can extract data via a JDBC connection from the Unified Manager database. Starting with Unified
Manager 7.3, multiple schemas are exposed providing flexibility to customers to create reports from any
storage object monitored by Unified Manager, including performance reports. This is explained in Section
11

12.3 Export Data Directly from Unified Manager GUI

Various reports can be extracted directly from the Unified Manager GUI. The reports can be extracted in
CSV format directly to your desktop, including performance data.

You can customize the views and export the views in CSV format right to your desktop. However, you
cannot save the customized views for next login.

The following subsections show all the data that you can extract from different areas of the GUI:

Health Tab

Navigate to the Health tab on the left-hand side of the Unified Manager GUI screen. You can select views
from the sub-tabs under the Health tab.
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Health - Clusters Page

Health / Clusters €

/b\View Monitoring Status @ Annotate | spRefresh List & Export
D « ¥ Cluster ¥ Communicati.. ¥ SystemHealth ¥ Hostname or |P Address ¥ OSVersion ¥ Node Count Last Refres' ed Time:
] €3 clus_cpef3270-104-35-36-40-42 Good Degraded 10.225.235.193 Fullsteam__8.3.0 4 10Jan 2018, 20:38
D 0 ot um-mobility-01-02 Good 0K 10.221.176.53 Kalyaniblack__%.4.0 2 11 Jan 2018, 01:58

Health > Nodes Page

Health / Nodes €&
* T | MNode T State Y HAState T Cluster T Model T OS%e.. ¥ AllFlash Optimized T Location T Aggregate Used Capacity ¥ [5R|
O fa270-104-42 Down ‘Warning clus_cpe-fa270-104-36-3.. Fullsteam.. 0 bytes -
iy fa270-104-40 Up Warning clus_cpe-fa270-104-36-3.. FAS3270 Fullsteam... Neo GOL 147 TE
a f3270-104-36 Up Mormal clus_cpe-f3270-104-36-3.. FAS3270 Fullsteam... HNo GDOL 1.33TE
6 f3270-104-38 Up Mormal clus_cpe-f3270-104-36-3. FAS3270 Fullsteam No GDOL 72543 GB
O ocum-mobility-01 Up MNormal ot um-mobility-01-02 AFFB080 Kaly anibl. Yes GDL 515.95 GB
a ocum-maobility-02 Up Mormal ot um-mohbility-01-02 AFFB8080 Kaly anibl Yes GDL 1.05TE

Health & Aggregates Page

Health / Aggregates &

# Edit Threshold & Export
D « ¥ | Aggregate Y State T HNode T Type T SnaplLock Type T Available Data Capacity ¥ | Total Data Capacity ¥  Committed Capa... ¥ S[EH|
D 8 f327010438_aggrs Failed f3270-104-38 HDD Non-SnaplLock 0 bytes 0 bytes 0 bytes -
I:| 8 aaci_aggr2 Failed f3270-104-38 HDD Men-Snaplotk 0 bytes 0 bytes 0 bytes H
D O aggri Online ot um-mobility-01 SSD Non-Snaplotk 3037TB 307 TB 6417TB

Health = Storage Virtual Machines Page

Health / Storage Virtual Machines €

|:| « ¥ Storage ‘frtual Mac hine T State T Cluster T  Alowed Volume Type T Available Data Capatity 7 Total Data Capacity T
I:‘ 8 f327010442_aggrS_ve3d3 Running clus_cpe-fa270-104-36-38-40-42  FlexVol 0 bytes 0 bytes -
I:l 0 f327010442_sggrs_vs4s Running clus_cpe-fa270-104-36-38-40-42  Flex\Vol D bytes 0 bytes
D 0 f327010442_aggr_vsdd Running clus_cpe-fA270-104-36-38-40-42  Flex\/ol D bytes 0 bytes
D 0 vservershadowed_fire_138510... Running clus_cpe-f3270-104-36-38-40-42  Flex\/ol 0 bytes 0 bytes
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Health & Volumes Page

Health / Volumes €
Y E #Restore Q@ Annotste
[ = ¥/ volume T State ¥ Junction Path
D 0 netapp Offline
D 8 jega_perfl_vol_gtree_nest...  Offine !
[ €3 27010436 _sggri_vsi_v... Offine
[ €3 27010436 _sgori_vs1_v... Offine
— -

Performance Tab

Y Storage \irtual Machine T Aggregates

evptest
jaga_perf_vol_gtree_nest..
f327010436_aggr1_vs1

f327010436_aggri_vs1

T Tiering Policy
aaci_sggrd

327010436_aggré

aaci_aggrl

aaci_aggrl

-

T SnaplLock Type T Protection Role T

MNon-Snaplock Unprotected |:|
Non-Snaplock Unprotected

MNon-Snaplock Protected

Mon-Snaplock Protected

Navigate to the Performance tab in the left hand side of the Unified Manager GUI screen. You can select
views from the sub-tabs under the Performance tab.

Health

Q)

Performance

Clusters

MNodes

Aggregates

Volumes

Paorts

SVMs

LUNs

LIFs
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Export Top Workload Data as Report

With Unified Manager 7.3, you can download top performers for Aggregates, Clusters, Volumes and
LUNs. You can select metrics like latency, IOPS, Mbps, Aggregate Utilization, Node Utilization, Perf
Capacity Used etc..

Examples:

Top 10 Aggregates

msara...aggr!

Metric Sort | Highestto Lowest =

10PS
MBps

Aggragate Utlization
Perf, Capacity Used

aggr.test aggr manuAggr 4

Performance / Cluster: opm-simplicity

Summary Top Performers Explorer Information

Dopm-s..ty-02

Sort | Highestto Lowest  ~

10PS

MEBps
Node Utilization
Perf. Capacity Used

opm-5...ty-01 2 3 4

Performance - Clusters Page

Performance / Clusters &

I10PS, MBps are based on hourly samples averaged over the previous 72 hours

el Y Filtering
[mE3 Assign Performance Threshold Policy Clear Performance Threshald Policy
[]| status ¥ Cluster 10PS MBps Free Capacity
O ocum-mobility-01-02 61,975 10PS 471 MBps 299TB
O clus_cpe-f3270-104-36-38-40-42  N/A N/A 11878
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Select and export

Select and export

Total Capacity Node Count

314718 2

15.3TB 4

You can export and download all of the data shown in the grid to a .csv file.

. * Export

Switch to Health View n Last updated: 01:48 PM, 13 Sep

Time Range | Last72Hours

* Export

Last updated: 02:13 PM, 23 Jan Refr|

* Export i

d Poli

Cancel Export to CSV

alyaniol., 92

1-80-000011 Fullsteam_8.3.0
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Performance 2 Nodes Page

Performance / Nodes © Lastupdated: 02:33 PM, 23 Jan

Latency, IOPS, MBps, Utilization are based on hourly samples averaged over the previous 72 hours

Y Filtering », Export E|

O~ Assign Performance Threshold Policy Clear Performance Threshald Policy

Available Columns Columns to Display ‘
i . Flash Cache Reads - Status -

[ | status ¥ Node Latency 10PS MBps Perf. Capacity

Node
O ocum-mobility-01 9.89 ms/op 17,588 I0PS 139 MBps 2%

Latency
O 3270-104-36 N/A N/A N/A N/A ‘ aps
O ocum-mobility-02 8.68 ms/op 44,376 I0PS 332 MBps 39% B

ps

D 3270-104-38 N/A N/A N/A N/A ‘ >

Perf. Capacity Used
D 3270-104-40 /A N/A /A N/A

Utilization
O 3270-104-42 N/A N/A N/A N/A ‘

Free Capacity

Total Capacity
Cluster

Threshold Policy

Nodes selected: 0 ‘ Reset Cancel Apply Columns ‘

Performance 2 Aggregates Page

Performance / Aggregates & Last updated: 02:17 PM, 23 Jan

Latency, IOPS, MBps, Utilization are based on hourly samples averaged over the previous 72 hours

Y Filtering

O~ Assign Performance Threshold Policy Clear Performance Threshald Palicy
[/ Cluster Status ¥ Aggregate Aggregate Type Latency 10PS MBps Perf. Capacity | Utilization Free Capacity Total Capacity Node Threshald Polit
[ dlus_c..40-42 327010442_aggr3 HDD /A /A /A /A A 732GB 745GB 3270-104-40 =
[ dus_c.40-42 327010442_aggr1 HDD N/A /A /A /A /A 736 GB 745GB 3270-104-40
[1| ecum-m...1-02 aggro_vs SsD 0.806 ms/op 8.4610PS <1 MBps <1% <1% 1.14TB 1.15TB ocum-...y-01
= ___ ____ ___ N P— A . — ________
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Performance = Volumes Page

Performance / Volumes &

Latency, IOPS, MBps are based on hourly samples averaged over the previous 88 hours

Search Volume data Y Filtering
O~ Assign Performance Threshold Policy Clear Performance Threshold Policy
[] | status  If volume style Latency 10Ps MBps
] 327010438 _ag...s10_vol2679 | FlexVol N/A N/A N/A
D 327010438 _a..._vol DP1750 | Flexvol N/A N/A N/A
D 327010438 _ag..510_vol2305 | Flexvol N/A N/A N/A
M Siman Al rafin Elaviinl 114 mctan 17 1.1NBC <1 MBnc

Performance 2 Ports Page

Performance / Ports &

MBps, Utilization are based on hourly samples averaged over the previous 72 hours

Y Filtering
O~ Assign Performance Threshold Policy Clear Performance Threshold Policy
[ status ¥ Port Type MBps
O e0a Network Port N/A
O etb Network Port N/A
Il ela Netwark Part N/A

Performance - SVMs Page

Performance / SVMs @

Latency, IOPS, MBps are based on hourly samples averaged over the previous 72 hours

Y Filtering
- Assign Performance Threshold Policy Clear Performance Threshold Policy
[]|status  IF svm Latency 10PS
O 327010442 _aggrs vs69 N/A NAA
O 327010440 _aggr2 vs48 /A N/A
D hells_consulates_1385085468 _vs N/A N/A
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Free Capacity Total Capacity Cluster

1.75MB

19.9 MB

1.73 MB

202nR

Utilization

N/A

N/A

N/A

MBps
N/A
N/A

N/A

19 MB
20 MB
19 MB

are

Cluster

clus_cpe-...38-40-42
clus_cpe-..38-40-42

clus roe-. 3R-40-42

Node

Last updated: 02:20 PM, 23 Jan

2 Export el

SVM Aggregate Tiering Policy Threshold Pol

clus_c..40-42 | f3270-104-38  f32701..vs10  f3270..ggr4
clus_c..40-42 | f3270-104-38  f32701..vs10  3270..ggrd
clus_c..40-42 | f3270-104-38 | f32701.vs10 | f3270..ggr4
Arm. 0 L aeiems wmt | uea ameres e
Last updated: 02:21 PM, 23 Jan
3, Export o3
Node Speed Role Threshold Policy
f3270-104-42 1,000 Mbps Cluster -
3270-104-42 1,000 Mbps Cluster
3270-104-42 1000 Mhns Nata
Last updated: 02:22 PM, 23 Jan
», Export o3
Free Capacity Total Capacity Cluster Threshold Policy
0KB 0KB clus_cpe-f..-38-40-42 =
972 MB 973 MB clus_cpe-f...-38-40-42
0KB 0KB clus_cpe-f..-38-40-42
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Performance 2 LUNs Page

Performance /LUNs & Lastupdated: 02:25 PM, 23 Jan
Latency, |OPS, MBps are based on hourly samples averaged over the previous 88 hours.
L T Filtering 2 Export el
(WE3 Assign Performance Threshold Policy Clear Performance Threshold Policy
[J|status 1F LUN Latency 10PS MEBps Free Capacity Total Capacity Cluster Node SVMm Aggregate Volume Threshold Palit
O Mvalif32701043..._vol360lung19 | N/A N/A N/A 4MB 4MB clus_c..40-42 | 3270-104-38 | f32701..vs510  f32701... 32701...0l560 =
D Molif32701044.0l630lun1246 | N/A N/A N/A 4MB 4MB clus_c..40-42 | f3270-104-40 | f32701..vs14 | f32701..aggr2 | f32701..0l630
| Molif32701043..v012357Iun143 | N/A N/A N/A 4MB 4MB clus_c..40-42 | f3270-104-36 | f32701...2_vs2 | f32701..aggr2 | f32701..12357

Performance - LIFs Page

Performance / LIFs @ Last updated: 02:27 PM, 23 Jan

Latency, IOPS, MBps are based on hourly samples averaged cver the previous 72 hours

T e i

O~ Assign Performance Threshold Policy Clear Performance Threshald Palicy
[1|status ¥ vLIF Type Latency 1oPS MBps Cluster Home Location  Current Location Role Threshold Policy
N rgrpCaimen_15_7 Network LIF N/A N/A N/A clus_cpe...8-40-42 | f3270-104-40:e1a | f3270-104-36:e13 ata -
O rgrpCaimen_12_11 Network LIF N/A N/A N/A clus_cpe...8-40-42 | f3270-104-38:e1a | f3270-104-38:e1a | Data
O vs3_nfs_lif1 Network LIF N/A N/A 56.1 MBps ocum-mo...01-02 | ocum-mob...-02:e0 ocum-mab...-02:e0| D
N rgrpCaimen_15_8 Network LIF N/A N/A N/A clus_cpe...8-40-42 | f3270-104-40:e1a | f3270-104-36:e1a | Data
[} rarnCaiman 17 17 Matwerk | 15 Lurs (7S nsa Fluc rma 2047 | 2970010420813 | 29700104 220810 | D

Protection Tab

Expand the Protection tab to gather details from the sub-tabs.

Protection = Volume Relationships Page

Protection / Volume Relationships €

> Refresh List

[Fl| « ¥| LagStatus ¥ Transfer Status ¥ Relationship Type ¥ Source SUM ¥ Source Volume ¥ Destination SUM ¥ Destination folume Y Lag Duration ¥ Last Transfer Duration

[} O Idle Snapirror Resource-key not discov Resource-key not discov 327010440_agor2_vs14 1327010440_aggr2_vs14_ |j
=] 0 Idle Snaphirror Resource-key notdiscov...  Resource-key notdiscov...  f327010440_agorZ_vs14 327010440_aggr2_vs14_

= O Idle Snaphirror Resource-key not discov Resource-key not discov 327010440_agor2_vs14 327010440_agar2_vsi14_

[} G Idle SnapMirror Resource-key not discov Resource-key not discov 327010440_agor2_vs14 1327010440_aggr2_vs14_
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Capacity Trending Charts

Trending charts are available with each of the Volume and Aggregate detail pages. Charts in the drop
down menu provides different levels of trending data. The data is retained for one year, and users can
plot graphs for one week, one month or one year

Volume Page

History

[«

| |
Show: | Volume Capacity Used |VIJ im || 1y
“olume Capacity Used
Yolume Capacity Used vs Total

Yolume Capacity Used (%)
Snapshot Capacity Used (%)

Aggregate Page

History

[

Show: | Aggregate Capacity Used (%) b im || 1y

Aggregate Capacity Used (%)
Aggregate Capacity Used vs Total Capacity
Aggregate Capacity Used (%) ve Committed (%)
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13 Frequently Asked Questions

1. Can change units from GB to TB and vice versa on the Capacity Reports?

Answer: Yes, you can change details in any report. For Capacity reports, you need to create a
new column (Advanced Column - Computed Column) to convert capacity numbers into the units
you want; for example GB - TB.

Follow the steps detailed in Example 1

2. What tool can I use to build custom reports, and run a SQL query to the Unified Manager
Database?

Answer: You can take any IDE of your choice as long as it supports JDBC connectionto the
MySQL database (Unified Manager Database).

3. Isthe Eclipse tool free of cost?

Yes, an open source version of Eclipse is available, as explained in Section 8.1

References

¢ NetApp OnCommand customer community in which users post questions and subject-matter experts
respond and in which users can interact with peers
http://community.netapp.com/t5/OnCommand-Storage-Management-Software-Discussions/bd-
p/oncommand-storage-management-software-discussions

¢ OnCommand Unified Manager on NetApp.com
http://www.netapp.com/us/products/management-software/oncommand/

¢ OnCommand Unified Manager on the NetApp TechComm TV channel on YouTube
https://www.youtube.com/watch?v=34P zoOKuMOQ

¢ Download site for the latest version of Unified Manager and product documentation
mysupport.netapp.com
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Refer to the Interoperability Matrix Tool (IMT) on the NetApp Support site to validate that the exact
product and feature versions described in this document are supported for your specific environment.
The NetApp IMT defines the product components and versions that can be used to construct
configurations that are supported by NetApp. Specific results depend on each customer’s installation in
accordance with published specifications.
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